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Read Me First

Welcome to Take Control of Your M-Series Mac, version 1.0, published in March 2021 by alt concepts inc. This book was written by Glenn Fleishman and edited by Joe Kissell.

This book will help you configure and protect your Apple silicon M1-based Mac. You will learn to manage new features and work with its advantages and constraints, while understanding the comprehensive changes across hardware and macOS from Intel Macs.

If you want to share this ebook with a friend, we ask that you do so as you would with a physical book: “lend” it for a quick look, but ask your friend to buy a copy for careful reading or reference. Discounted classroom and user group copies are available.

Copyright © 2021, Glenn Fleishman. All rights reserved.


Updates and More

You can access extras related to this ebook on the web (use the link in Ebook Extras, near the end; it’s available only to purchasers). On the ebook’s Take Control Extras page, you can:


	Download any available new version of the ebook for free, or buy any subsequent edition at a discount.


	Download various formats, including PDF, EPUB, and Mobipocket. (Learn about reading on mobile devices on our Device Advice page.)


	Read the ebook’s blog. You may find new tips or information, as well as a link to an author interview.




If you bought this ebook from the Take Control website, it has been added to your account, where you can download it in other formats and access any future updates.





Introduction

The new series of Apple silicon Macs that use the company’s M1 system-on-a-chip offers remarkable advances in performance, battery life, and memory utilization. These new models sport a range of firmware and hardware changes that make them different in many ways from all Macs that come before them.

This includes unique advantages, such as running iOS and iPadOS apps, and providing even stronger protections baked into hardware against attackers trying to take over your Mac.

Take Control of Your M-Series Mac digs into the important stuff that lets you take advantage of new features, while also performing routine tasks that have changed in large and small ways, such as backing up your Mac and protecting it.

That starts with understanding how the M1 chip works, what makes it different from Intel processors, and how to migrate successfully from an Intel Mac. The book then moves into specifics: How do I back up an M1? Can I create a backup on an external drive that I can boot from? How do you manage the absurdly long battery life? What’s different when I restart in recovery mode?

The book also digs into system security, which covers the Big Sur-specific changes available to all Macs with the particular spin you find in an M1 Mac. Finally, I explain the ins and outs of using iOS and iPadOS apps in macOS, and the early stages of running Windows within macOS on an M1.


Note: Because we know the M1 is just the first in what will be a series of chips, we chose to title this book with the term “M-Series.” As I write this, the book covers the M1, the only Apple silicon so far released, but future versions will incorporate information about new chips and Macs.





M-Series Quick Start

This book both teaches you about how the M-series chips work and the differences they have from Intel processors, and offers insight into areas like battery life, backups, security, and recovery. You can read most of the book in any order.


Start with background:


	It’s useful to understand how the M-series chips work and how Apple baked security right into the chip; see How Apple Silicon Works and How Security Is Baked In


	Learn about the extended battery life with M-series Macs and how to measure and manage it; see Work with Extended Battery Life






Prepare for and recover from problems:


	Understand how backups work in Big Sur with an M-series chip; see Back Up Your M-Series Mac


	Get to know recoveryOS, the new special boot option for reinstalling macOS, controlling security, and more; see Understand recoveryOS






Dig into Security:


	Figure out whether FileVault’s extra protections work for you; see Protect a Drive with FileVault


	Learn about Big Sur’s extra protections for system files; see Protect a Drive with FileVault


	Modify system security for specific purposes; see Protect a Drive with FileVault






Run Something Different:


	Most iOS and iPadOS apps can be installed and run on an M-series Mac; seeLaunch iOS and iPadOS Apps on Your Mac


	You can run a pre-release version of Windows that works on M-series processors today; see Install and Use Windows








Learn M-Series Details

The new M-series chips are profoundly different from the Intel generation they supersede. For those who have read up on the architecture of an iPhone or iPad, the M1 Apple silicon will seem familiar; those who haven’t may feel at sea. In this chapter, I explain how a system on a chip (SoC) works, what’s different from the Intel world, and how Apple bakes security into hardware in their own silicon.

You don’t have to be a chip-head or a hardware expert to understand the details that follow, nor will there be a test at the end. The idea is to give you a sense of what’s new—and sometimes extraordinary—inside the M1, and how special features enable entirely new capabilities.


Tip: If you find chip-based technical detail not quite as interesting as I do, skip ahead to How Security Is Baked In, which is more critical to understanding parts of the rest of the book.



How Apple Silicon Works

A traditional CPU-based system wastes a lot of time and energy moving data between it and other chips across a circuit board. Every time memory is manipulated, a security coprocessor needs to perform encryption tasks, or graphics operations have to be offloaded to a GPU (graphics processing unit), there’s a huge amount of signaling and voltage that consumes power, delays actions, and generates heat.

A computer will often also have separate chips for each type of controller, a combination of firmware and processor that manages communication with hardware devices. That includes standards like Thunderbolt, USB, and PCIe that connect your computer to printers, displays, and drives. (PCIe is typically used to connect expansion cards in computers with slots.)


Note: Some controllers come in multiples to create separate data paths, or buses, for different ports or sets of ports. The M1 Macs apparently have two controllers for Thunderbolt 3/USB 4, allowing two buses with up to 40 Gbps of throughput on each.


A computer also needs radio chips for Bluetooth and Wi-Fi (and sometimes cellular), as well as storage chips packaged as solid-state drives (SSDs).

On an Intel-based Mac (or an AMD- or Intel-based computer of any kind), the processor is a generic model available to any manufacturer. The rest of the chips required to make up the computer are largely commodity items, sourced based on cost and features. Apple uniquely has often designed or had made to its spec some secondary chips to provide a specific set of features or meet certain performance criteria.

But taken altogether, every CPU-oriented computer is a Frankenstein, however nicely assembled and however well every part works together.

In contrast, a system on a chip combines nearly every function into a single hunk of silicon. It is more like an organism designed in the lab and produced from scratch, in which each part is designed to work with each other. Instead of lumbering along and occasionally delivering 100-page soliloquies (Go read Frankenstein! The monster really does that!), a SoC is a thing of efficient beauty, as described in detail below.




CISC and RISC




The reason for the rise of SoCs is coupled with a long-term shift in computing from processors that use CISC (Complex Instruction Set Computing) to RISC (Reduced Instruction Set Computing). AMD and Intel’s PC-oriented CPUs devote several processor cycles to each command, letting them carry out complicated tasks all in one go. However, simple commands take just as long as complicated ones. Coding for such processors is hard to optimize for both simplicity and complexity, and the processors are by nature larger and more complicated than those that rely on RISC.

A RISC processor carries out one command per cycle, requiring more instructions to complete a complex task, but executing simple tasks faster. This allows compiler designers and programmers a lot more room to optimize code. The processors are simpler by some definitions, too, as they don’t need to know how to process as many different instructions.

Apple originally used CISC processors (the Motorola 68000 series). As RISC emerged, and CISC-chip maker Intel seemed joined at the hip with Microsoft, Apple formed a partnership with IBM and Motorola to develop the RISC-based PowerPC architecture, which it deployed in 1994. However, PowerPC designs didn’t improve fast enough for Apple’s liking, and in 2006 they adopted Intel’s newest generation of CISC processors. Intel’s speed improvements petered out over a decade as RISC rose to prominence again, including in Apple’s iPhones and iPads. Apple’s move to their own RISC-based chip designs was to assert more control—and to advance performance.

RISC processors aren’t per se better than CISC ones in terms of tasks they can perform, but over time their sheer efficiency and simplicity seems to have allowed them to advance more rapidly, and thus outperform their CISC counterparts through maturity.


Along with components that appear in most computers, Apple has also built in a machine-learning silicon engine. The company has counted that for years as part of its key strategy in iPhones and iPads, and now it’s an unfolding part of its strategy for the future of macOS, too.


Tiny Transistors and More

A system on a chip combines a CPU and other components into a single chip. While there’s a large development cost for such a chip, it dramatically reduces the per-unit cost of manufacture, because there are fewer pieces required and less assembly, and less can go wrong.

SoCs date back 30 years in a limited fashion for personal computers. It then became common not long after in “embedded systems,” which are standalone devices like DVRs, security equipment and sensors, and other equipment that has a single-purpose computing need.

Apple began using SoCs with the first iPhone in 2007, and started producing SoCs with its own designs in 2010 with the A4 that appeared in the iPad. All new models of iPad, iPhone, iPod touch, and Apple TV that followed use Apple’s A-series chips, and other SoCs were designed in house for the Apple Watch, AirPods, and HomePod.


Note: The chip-development company Arm is part of the reason for the success of SoCs. Arm grew out of Acorn, an early SoC and RISC developer, and Apple was an early investor. Arm develops processor designs, freeing companies up from this primary research. These designs are then licensed and adapted by companies like Apple, AMD, Broadcom, IBM, Microsoft, Nvidia, Qualcomm, and Samsung—really almost every hardware company in the field—which then largely contract out for chip fabrication.


Apple has followed similar principles with the first M-Series chip, the M1 (Figure 1). The M1 contains the CPU, GPU (graphics processing unit) that runs the display, memory, device controllers for Thunderbolt and other interfaces, security (the Secure Enclave and other elements), and caches that hold bits of code and data temporarily and often have a key role in improving processing throughput. This first model doesn’t include radio components or SSD storage.


[image: Figure 1: The chip package is exposed here (photo: Apple).]Figure 1: The chip package is exposed here (photo: Apple).

Apple also built its first M-series chip on what is known as the 5 nanometer (nm) process, which refers to the size of the tiniest units in the silicon. These small units have related heat and power advantages. The smaller the units, the less energy that’s consumed and the less heat generated. This allows smaller process chips to run faster without overheating, but also more efficiently. Combined, they conserve battery life better than comparable larger processes while requiring less cooling from fans or subsystems. “CPU performance per watt” is the measure, and Apple says the M1 is the best in the world.

Smaller processes also allow more components to be packed into the same space, as there are substantial physical limits on the maximum size of a single chip.

Apple is the first company to build a computer around 5 nm process chips, and was one of two to use such tiny circuits in mobile phones, starting with the iPhone 12 series in 2020. (Huawei was the other.)

Apple’s first Intel chips were 65 nm process back in 2006, and Intel currently mostly fabricates 10 nm and 14 nm chips today. Intel has a roadmap to a long-delayed 7 nm size—roughly the same as Apple’s 5 nm for technical reasons—no sooner than 2022. This probably played into Apple’s thinking about making its own transition. Intel competitor AMD has chips closer to Apple’s size, but there’s some vibrant discussion about whether the size labeling is directly comparable.




The M1 Wasn’t the First Mac SoC




Macs first featured a SoC starting in 2016 with the briefly used T1 chip, which enabled Touch ID and ran the Touch Bar. It was replaced in newer models the next year with the T2 security chip, which included a full Secure Enclave among other features. The T2 was always seen as a test of the feasibility of a full Mac ARM-based SoC.




Many Cores, Some Fast and Some Slow

CPUs used to be serially monolithic: they could do one thing in a sequence at a one time. Some very clever people realized that as chips shrunk in size per the above-mentioned reduction in processes it was feasible to copy and paste multiple CPUs on the same single chip, allowing them to run in parallel.

Each of these mini-CPUs is counted as a core, and can provide huge performance improvements without proportionately increasing the cost of manufacture or the devices on which they run. Nowadays, it’s hard to find a single-core device, except for some very low-end notebook computer and mobile phones.

Multi-core processors work best for tasks that can be divided to run simultaneously. Fortunately, that’s true for a lot of the most processor-intensive operations involving audio, images, video, and animation, and it’s a reason you can find GPUs with more cores than CPUs. It also allows serial tasks to run separately on different cores, like background operations or even different apps altogether.

Apple not only hopped on the multi-core bandwagon early, but also modified macOS to break out system operations to work in parallel, as well as offering developers frameworks for parallelization in their apps.

They also engaged a different tactic in their A-series chips for iPhones and iPads. After first adding multiple cores of the same kind, they bifurcated: A-series chips now have fast and slow cores. Fast cores blaze through tasks, but also eat a battery charge faster; slow cores get the job done more slowly but more efficiently. iOS and iPadOS spend some of their time assigning tasks appropriately among these cores to offer long battery life without frustrating users streaming videos, playing games, or performing other tasks that lean on the CPUs.

The M1 chip follows this practice (Figure 2). It’s designed as an eight-core CPU with four high-performance ones and four high-efficiency ones. Apple’s use of 5 nm process and this core approach allows for ridiculously long battery times on the MacBook Air and MacBook Pro models, while also putting out very little waste heat. (See Work with Extended Battery Life for how to manage that extended life.)


[image: Figure 2: Apple calls out the eight-core CPU in this illustration of the M1 chip (photo: Apple).]Figure 2: Apple calls out the eight-core CPU in this illustration of the M1 chip (photo: Apple).

An M1 Mac has a cool case nearly all the time, a noticeable contrast in circumstances where an Intel laptop would be firing up its fans and uncomfortable to touch.

The M1 also has an eight-core GPU, which is similarly very fast relative to previous GPUs, while also maintaining low energy consumption. You can see one improvement when switching among video resolutions on a laptop: the change is not just instant, but there’s no moment of a black screen between the old and new resolution.


Note: Apple cites a lot of improvements from its M1 compared to the “latest PC laptop chip,” which they don’t specify. However, head-to-head with the highest-performance AMD and Intel CPUs, the M1 performs extraordinarily well.




Lots of Extras

The M1 builds in a number of additional components as well. These include:


	Memory: As a SoC, this is common, but it means that an M1 Mac is just as limited to the amount of RAM it ships with as Intel Macs that had RAM soldered directly to the motherboard. The three models available so far only offer 8 GB and 16 GB configurations. However, memory is used so much more rapidly and efficiently that a 16 GB M-series Mac seems to outperform Intel Macs with 32 GB or 64 GB. (That includes my 2017 quad-core with 64 GB.) The general sense before the M1 was that once computers had shifted largely to SSDs for storage, memory was a bigger blocking factor than processing power in improving performance. That has been upended.


	Secure Enclave: As I discuss next in How Security Is Baked In and Manage System Security, the M1 chip includes the Secure Enclave, which is also part of later A-series chips for iPhone and iPad and the T2 Security Chip found in recent Intel Macs. In labeled diagrams of the M1, Apple doesn’t identify the Secure Enclave, perhaps to add to its security? (Touch ID relies on the Secure Enclave, but is only available on laptop Macs.)


	Controllers: Apple built into its M1 the latest flavors of the most popular connection buses: Thunderbolt 3 and USB 4.


	Neural Engine: Apple has increasingly designed and integrated circuitry for machine-learning processing into its A-series iPhone/iPad chips. The M1 builds on that. macOS on an M1 Mac can tap the 16-core Neural Engine for any AI-related task in Apple’s apps and third-party apps. This includes an intelligent framing operating in Final Cut Pro. Previously, Mac apps had to lean on the CPU for these tasks. This new capability remains to be explored.





Note: Machine learning relies on applying highly specialized, previously trained models against fresh data. The results can be spectacular, like producing convincing live video from a series of still images, identifying common objects in photos and videos without requiring labeling or captioning, or producing word-perfect audio transcription. But it requires a lot of processing oomph that hasn’t been readily available in a computer before.





How Security Is Baked In

In Intel Macs shipped started in 2016, Apple began to add a security coprocessor. The T1 SoC was the first, but it appeared only on the 2016 and 2017 MacBook Pro models with a Touch Bar, and handled just Touch ID and a few unrelated purposes.

The T2 security chip was much more significant. Built into Mac starting in 2017, it features the Secure Enclave, a component that began appearing in iPhones as part of Touch ID. With M1-based Macs, the Secure Enclave is built in as part of the M1 SoC. That’s an improvement, making it even harder to access physically.

The M1 also has a few hardware-based upgrades as part of the ARM chip architecture that weren’t possible with Intel chips, which I discuss after the Secure Enclave.


Secure Enclave Keeps Secrets

The Secure Enclave is a vault that handles encryption secrets, biometric information, and many kinds of private data. It’s designed for a lot of one-way operations and queries, and many kinds of data cannot be retrieved from it.

On a Mac with Touch ID and a Secure Enclave (either the T2 or M1), as you enroll your fingerprints and train the sensor to your ridges and whorls, that data is sent directly into the Secure Enclave, never to emerge. When you attempt to use Touch ID in the future, your Mac derives the characteristics of your attempt and passes some information about it to the Secure Enclave. The Secure Enclave then replies with a, er, thumbs up or down, which macOS processes. You can’t modify your stored fingerprints, but have to delete one or more and re-enroll them if they become less accurately recognized over time.

As part of the M1, the Secure Enclave is as tamper resistant as the rest of the chip. Any attempt to extract or manipulate its contents with tiny tools will more than likely destroy the chip’s contents.

On an M1 Mac or a Mac with a T2 chip, the Secure Enclave is used for a number of different purposes:


	Touch ID: As noted above, fingerprints are enrolled and stored securely within, with macOS querying the Secure Enclave to confirm matches at login.


	SSD encryption: All M1 Macs feature SSDs, and they have hardware-based always-on disk encryption. This is intertwined with the separate FileVault technology; see Enable and Manage FileVault.


	Boot integrity: The Secure Enclave has some hardcoded information that prevents subverting a Mac when it starts up. Startup is a bootstrap process, like “pulling oneself up by one’s bootstraps.” Little bits of software get more complicated pieces of software running in a cascade until the OS is running. With the Secure Enclave, the first stage is loaded from read-only memory—instructions burned permanently into silicon—and each subsequent stage relies on encrypted validation to ensure nothing has changed.


	Storage of encryption keys: Apple uses the Secure Enclave to keep the raw stuff of encryption unavailable to anyone—even Apple. Developers can also make use of the Secure Enclave to manage keys they want their apps to store.


	Per-file encryption: The M1 allows third-party developers to encrypt individual files using an Apple framework with the full protection of the Secure Enclave. Because the encryption is handled entirely within the M1 chip, performance remains as fast with encrypted files as with unprotected ones. A developer also doesn’t have to build their own encryption software, or rely on open-source or licensed encryption code that they don’t control.




The Secure Enclave has no management associated with it. It’s just neatly there carrying out cryptographic and validation operations behind the scenes.

If your Mac is lost or stolen and you want to erase its contents remotely, the Secure Enclave allows this process to happen almost instantly.




Recover Broken Secure Enclave Firmware




Technically, the Secure Enclave runs the Secure Enclave Processing operating system, or SEP OS. This operating system can become scrambled in certain circumstances, which can make a Mac non-responsive. Fortunately, Apple offers a way to revive, or try to fix, broken SEP OS firmware, while preserving your data. Failing a revival, it can also wipe and restore the firmware, although your files will be lost. I explain the steps and where to get even more information in Revive or Restore a Broken Startup Volume.




Other Hardware Security Upgrades

Beyond the Secure Enclave, the M1 has additional hardware-based protections:


	System integrity: Although System Integrity Protection (SIP) has been around since OS X 10.11 El Capitan as a way to lock system files during an active macOS session, the M1 chips adds an additional hardware-based system integrity element. Only a version of macOS that’s been approved by Apple can run, and while macOS is active, the M1 chip continuously validates every piece of system software that executes and every system file that’s read. See Manage System Security for more detailed information about how to work with these protections.


	Hardware-based kernel protection: After macOS loads on an M-series Mac, the memory occupied by its central components—its kernel—is locked using “kernel integrity protection,” so it cannot be modified while macOS is running.


	Locking memory for executing or writing: Apple silicon has a nifty feature that defines each segment of memory, or pages, used for apps as being locked in one of two exclusive states at any given time: executable (can run code) or writable (can store data). (In fact, the company tells developers that this technology is “Write XOR execute”: XOR means “exclusive or,” a logic term for “either of these but not both.”) This prevents malware from using a common hacking technique of exploiting errors in the operating system or app to overflow where an app stores data into a code area. The malicious code is then executed instead of the legitimate instructions. By locking each area in one state, it’s extremely difficult for this kind of attack to succeed.


	Partitioning device access to memory: On an Intel Mac, any hardware connected via PCIe (an expansion bus used for connecting controllers for super-fast drives, external GPUs [eGPUs], and audio and video interface cards) can access any part of a pool of system memory. Compromising firmware in a peripheral or controller could allow access to all sorts of information on a Mac. With M-series Macs, PCIe devices are restricted to their own set of memory. (The M1 Macs have internal PCIe connections; it’s likely we’ll see external support for eGPUs in future M-series iMacs and Mac Pros, as well as internal card slots in Mac Pros.)


	Security with a new architecture: The ARM architecture and changes in the built-in version of the Secure Enclave and other security features in the M1 avoid a couple of nasty bugs that can be exploited with Intel Macs. A full explanation can be found at this Apple Insider article.









Migrate from an Intel Mac

Most of us aren’t starting from scratch when we set up an M-series Mac. We have a previous computer with an Intel chip built in that has an operating system with a particular configuration, and software and files that go with it.

First, if you haven’t yet purchased an M1-based Mac or want the full details on hardware aspects, read Pick the Right New Hardware. External displays are one of the key stumbling blocks when planning a purchase or (if you already own an Apple silicon Mac) when trying to figure out how to expand.

Then read Run Old and New Code on an M1 and the rest of the chapter to understand how Mac apps written for Intel models can run on an M1 chip, and the limitations of that for now.


Pick the Right New Hardware

Apple offered just three models of Mac at its introduction of M-series chips: the MacBook Air, the 13-inch MacBook Pro, and the Mac mini. While the chips run fast and offer nearly identical features, there are some slight differences that can affect migration.


Note: Wow, do I expect that this will change in future updates to the book! I can’t wait!



Processor, GPU, and Neural Engine

Oddly, a key aspect of most other Mac purchases is nearly the least-important factor with an M1 Mac. Every model save one comes with the same eight-core CPU, eight-core GPU, and 16-core Neural Engine.

The exception? The least-expensive MacBook Air has a seven-core CPU option, even though the chip is manufactured in the same way as eight-core versions. Experts believe reflects a yield issue on the M1 chip: some have a single core that fails, and rather than ditch the chip, Apple uses the otherwise perfectly fine SoCs in this Air model. That allows Apple to offer the entry-level version at $999 for 8 GB of RAM and a 256 GB SSD. Bump it up to a 512 GB SSD to compare it against the minimum configuration of an eight-core Air, and it’s still $100 less.



Display Limits

The most significant difference between the laptop models and the Mac mini, and likewise between the M1 laptops and their preceding Intel counterparts, is in the number of external displays each supports.


Note: All displays connected to Intel and M1 Macs can refresh at up to 60 hertz (Hz), regardless of resolution.





Resolutions Defined




To be confusing, there are multiple resolutions available with the same abbreviation. Here’s the rundown:


	4K: 4096 pixels wide by either 2304 or 2160 pixels tall


	5K: 5120 by 2880 pixels


	6K: 6016 by 3384 pixels





Just for clarity, the last Intel-based versions of each model supported these configurations of monitors:


	Intel MacBook Air and 13-inch MacBook Pro (early 2020): Both models can drive via Thunderbolt 3 connections either two 4K displays (2304 pixels tall), one 5K display, or one 6K display. The MacBook Pro additionally can show high-depth video (billions of colors) at 5K or 6K. The two 4K monitors for both models and the 5K or 6K with a MacBook Air are limited to 24-bit, or millions of colors.


	Intel Mac mini (late 2018): An Intel Mac mini can connect up to three displays. Via HDMI 2.0, the mini can drive a 4K (2160 pixels tall) monitor. Via Thunderbolt 3, it can also drive either two 4K (2304 pixels tall) displays or a single 5K display.




The M1 13-inch MacBook Pro and MacBook Air each have two Thunderbolt 4 ports, but are limited to a single external monitor each. The Mac mini can handle two displays, but with some provisos. Here are the specs for each model:


	M1 MacBook Air and 13-inch MacBook Pro (late 2020): One external display up to 6K over Thunderbolt 3 (4K height not listed)


	M1 Mac mini (late 2020): One display up to 6K resolution via Thunderbolt 3, and one display up to 4K (height not listed) using the HDMI 2.0 port




One monitor fewer on these computers is a showstopper for some people. That’s particularly the case if you want to use your laptop as both a machine on the go and “dock” it on a desk with two large or high-resolution external monitors.


Warning! Apple won’t be releasing a software or firmware update that allows for more monitors or higher-resolution displays to be used with these initial computers. The limitations are built into the M1 SoC.


We don’t know Apple’s thinking about the future, but it’s absolutely certain that some future M-series Macs will allow for up to four 4K displays or one 5K and one 6K display—or potentially two 6K displays.



Peripheral Ports

The M1 Macs are the first in the lineup to support the combination of Thunderbolt 3 and USB 4 using USB-C. The MacBook Air and 13-inch MacBook Pro each sport two USB-C ports and an audio jack.

The Mac mini adds two USB Type-A ports, an HDMI 2.0 port for an external monitor, and a jack for gigabit Ethernet.

Tim Standing at One World Computing dug into the M1 bus, and discovered something interesting. Intel Macs with four Thunderbolt 3 ports have two controllers, splitting bandwidth and other support between two ports each. The M1 has a separate controller for each of its two Thunderbolt 3 ports on the three models shipped.

That might seem like a worse deal, particularly with the laptop limitation on displays. However, Standing notes Apple has included an optional feature in Thunderbolt 3 in its Intel and M-series Macs: support for a Thunderbolt hub that allows multiple Thunderbolt ports to handle off a single host port. Thus, by adding a hub—like the one his company offers—you can attach multiple USB 3 or Thunderbolt 3 devices.



Memory and Storage

As I noted earlier, an M-series Mac has its memory built into the SoC, not just soldered onto a circuit board. Many recent Intel Macs couldn’t have their memory upgraded, either; that’s also true of these new models, just in a different way!

Thus it is just as vitally important to figure out if you can live with 8 GB for your term of ownership of an M1 Mac, or if 16 GB is required to future-proof the purchase. I always argue towards more memory. The performance of the M1 is high enough with 16 GB that it makes more sense than with nearly any previous Mac ever shipped to bump your memory at the time of purchase.


Note: These M1 memory options don’t imply a restriction on future M-series chips. It is absolutely certain that some future Macs will incorporate 32 GB and 64 GB on the SoC. Whether a Mac Pro will offer memory slots, too, is unclear to me based on the architecture.


Apple offers more flexibility in the SSD storage available on each of these first three Macs with Apple silicon: 256 GB, 512 GB, 1 TB, or 2 TB. Some ready-to-order configurations of these Macs ship with a minimum of 512 GB of storage, however.




Run Old and New Code on an M1

Apple has managed a neat trick across nearly three decades of migrating operating system and processor architectures multiple times. During each migration, they rely on pushing app developers to make changes to their apps or releasing a limited-purpose emulator to get the migration over the hump of app transition.

Emulation is a neat trick, which I’ll explain briefly next, and it works seamlessly and with absurdly good performance on M1-based Macs. But Apple carved out just a portion of what was left behind with Intel models, and I’ll explain what that means at the end of this section.


What Is Emulation?

An emulator is a program that fools an app into thinking it’s running on a different operating system, or fools an entire operating system into the belief it’s running on a different processor than the one it really is. Software that runs within the emulator is a “brain in a jar”: to it, its world appears normal, and it doesn’t know that it’s running in a sort of Matrix-like simulation on another system than the kind on which it was designed to run.

An emulator is distinct from a virtual machine, which doesn’t require emulation to operate. A virtual machine is like a computational partition: it lets something run natively on the processor that is operating the primary computer—no emulation involved—but it’s partitioned off from the primary operating system running on that computer. A virtual machine provides an environment, sometimes called a “box,” which allows the speed and simplicity of native code execution instead of processor-based code emulation. Virtualization can encompass an entire operating system running within a virtual machine app, or it can be designed to run one or more specific pieces of software designed for one operating system seamlessly within another.

For instance, if you want to run an older version of macOS on an Intel Mac, you can turn to virtualization software like Parallels Desktop, VMware Fusion, and VirtualBox, all of which give you an operating system inside an app. In those same apps on an Intel Mac, you can also launch an Intel-based 64-bit Windows, as well as Linux, older versions of macOS, and more exotic operating systems.




Hypervisors Allow Multiple Virtual Machines at Once




A special-purpose program designed to allow multiple virtual machines to run side-by-side is called a hypervisor. The above-named apps including hypervisor software—Parallels even offers the choice of its own or Apple’s—or an operating system designed to run on server-class hardware that has its entire job as managing resources among virtual machines.

You can rent a virtual machine at a data center from many companies, such as Linode; such virtual machines are often called virtual private servers (VPS). These servers offer nearly all the power of having your own machine with none of the hassles of owning hardware. My websites run on a VPS, as does Take Control Books.


An emulator can also be designed to run limited subsets of software or just a portion of an operating system, but it always has to transform instruction from one process to another. Apple has offered four different transition tools—three emulators and one virtual machine—across their history that allow a newer Mac or operating system to run apps intended for older CPUs or versions of macOS.




The Timeline of Emulation




For those interested, the timeline of processor and operating system migration looks like this:


	Motorola 68040 to PowerPC: Apple built a “68K” emulator to allow software written for the late-generation 68040 processor to run in Mac OS starting in 1994 and lasting through Mac OS 9.2.


	Mac OS 9 to Mac OS X: Classic Mac software from Mac OS 9.04 and later ran within a virtual machine provided with Mac OS X. It was available from the public beta of Mac OS X around 2000 through Mac OS X 10.4.11 in 2007.


	PowerPC to Intel: The original Rosetta allowed most PowerPC software to function. It was available from Mac OS X 10.4.4 Tiger through 10.6.8 Snow Leopard.


	Intel to M-Series: Rosetta 2 allows most 64-bit Intel software to work on the M-series processors. Its end date hasn’t been set.





With the M1 processor, Apple offers Rosetta 2, which provides emulation for 64-bit Intel apps. When an Intel app runs with the help of Rosetta, Rosetta translates its Intel-based code on the fly to M1 ARM instructions.

Rosetta doesn’t have to handle every feature and operation on an Intel processor; it only needs to carry out the tasks that Mac software executes within macOS. Apple controls the entire environment in which Mac software is designed and compiled, and thus the company had to build Rosetta to emulate just what it allows developers to do within that structure.



How Emulation Works on an M-Series Mac

Rosetta isn’t installed automatically; rather, the first time you launch a 64-bit Intel app, macOS prompts you that it can download and install Rosetta (Figure 3).


[image: Figure 3: Big Sur prompts the installation of Rosetta.]Figure 3: Big Sur prompts the installation of Rosetta.


Note: Apple calls it simply Rosetta in the dialog above—and I will through the rest of this book—but more accurately refers to it as Rosetta 2 in its online support.



Note: Editor Joe Kissell was never prompted to install Rosetta on his M1 Mac; I was, and Apple says it’s a prerequisite. Go figure!


Once Rosetta is installed, 64-bit Intel apps simply run without any additional presentation or steps. When you first launch an app that’s compiled for an Intel Mac, macOS runs a translation process that converts all the Intel code to the ARM equivalent. It then runs the translation. On subsequent launches, the translated version is cached and runs instead, making a second launch much faster than the first.

Whenever you update an Intel Mac app, the next time it’s launched, Rosetta 2 has to perform its translation again.




What Can’t Be Translated?




Apple notes that kernel extensions have to compiled natively for ARM. (And Apple is deprecating kernel extensions for system extensions, as I explain in my book Take Control of Securing Your Mac.) You also cannot run virtual machines that require a different processor architecture, as described below.


Translated apps operate as fast as they are capable in emulation, which can be mighty fast. Adobe Creative Cloud’s production releases as I write this in March 2021 are still mostly written in Intel code—they released Lightroom and Photoshop for Apple silicon—but their second and subsequent launches are several times faster on my M1 MacBook Air than my 2017 quad-core iMac that has four times the memory.


Note: These apps run so rapidly that I will sometimes use screen sharing to bring up my M1 screen on one of my iMac displays instead of running the Adobe app natively on the iMac.





Apple Ditched 32-Bit Apps with Some Foresight




Apple prepared the way subtly for the M1 by having a nearly three-year set of warnings and phase-outs for 32-bit Mac apps—ones compiled for an older version of Intel processors, but that could still run compatibly with a framework included through the transition to more robust 64-bit processors and a macOS that was all reworked with 64-bit code.

While macOS 10.14 Mojave warned you when you launched a 32-bit app, macOS 10.15 Catalina wouldn’t run them at all. While this seemed like a smart way for Apple to have a crisp delineation and less overhead, it was also clearly a way for them to not have to deal with 32-bit Intel app support alongside 64-bit Intel app emulation!


You can tell ahead of time whether Rosetta is required to run a given piece of software by selecting the app in the Finder and choosing File > Get Info. In the Get Info dialog, the Kind item will show one of three labels after Application (Figure 4):


	Intel: Requires Rosetta


	Universal: Contains Intel and Apple silicon code, and this single binary can run natively on either platform


	Apple Silicon: Can only run on an M-series Mac, whether a native macOS app or a compatible iOS/iPadOS app (see Launch iOS and iPadOS Apps on Your Mac)





[image: Figure 4: The Get Info dialog’s Kind field reveals the code base used for the app and a checkbox for forcing a Rosetta launch.]Figure 4: The Get Info dialog’s Kind field reveals the code base used for the app and a checkbox for forcing a Rosetta launch.

For Universal apps, you can force the use of Intel code by checking “Open using Rosetta,” highlighted in Figure 4. This might be desirable in limited cases. Some apps allow for plugins and extensions, and developers of those add-ons might not have produced ARM-ready code yet. As a result, you want to force Rosetta to run to use the app along with the extensions.

In other cases, the Intel version may still lack features or be less erratic than the Apple silicon flavor, though that should change quickly. Adobe’s first pass at an M1-native Photoshop lacks several features, though most users don’t rely on most of them; those that do can opt to force a Rosetta run. (Adobe also demonstrates some Rosetta limitations, listing at that link a few problems when using Photoshop in emulation mode.)

Nearly all app developers are extending their Intel apps to be Universal rather than releasing separate Intel and Apple silicon software. There are a few exceptions. Google has released an M1-only version of Chrome, although its Intel version will run in emulation; you decide on the download page.

I’ve found some apps that you install directly—instead of copy from a download disk image—will opt for to install an Apple silicon-only version instead of a Universal one. Cisco WebEx and Zoom are two notable examples.

If you want to look comprehensively through your installed apps, you can hold down Option and choose Apple  > System Information, click the Applications link in the sidebar, and browse details. The Kind field offers several labels instead of the three above:


	32-bit (Unsupported): A 32-bit Intel app that can run only in macOS Mojave and earlier


	Apple Silicon: M1 native apps only


	Intel: 64-bit Intel apps


	iOS: iOS and iPadOS native apps


	Other: This category seems to include 32-bit Intel apps that are ancient enough to not even launch in Mojave


	Universal: Contains both Intel and ARM code in one package






Emulation Has Its Limits

Given the incredible performance of the first Apple silicon chip, you might wonder how versions of macOS before Big Sur as well as Windows 10 and other Windows releases might run on it. Keep wondering! Because, so far, you can’t run Intel-based operating systems on an M-series Mac, just 64-bit Intel Mac apps.


Note: You can install a preview version of Windows 10 for ARM, available through Microsoft’s free Windows Insider program, using a beta of Parallels. I provide the details in Install and Use Windows.


As I noted above, Rosetta is designed to provide a translation for a subset of Intel features that Apple developers rely on in coding their apps. It doesn’t pretend to be an entire Intel processor.

Virtual machines on Intel Macs don’t have to pretend to be a CPU. They act more as a mediator between the actual Intel CPU and the operating system and software they’re running in their little box. The Intel CPU directly executes the commands.

In order to emulate versions of macOS prior to Big Sur, any Intel version of Windows, and other operating systems designed to run on x86 chips, one or more people, open-source projects, or companies will have to build out a processor emulator that’s resilient and complete.


Note: Running Linux is much easier, since ARM-based versions were already available. It required investigation and some elbow grease. But Corellium had Ubuntu Linux running on an M1 about two months after the first M1s shipped.


They may have to worry that Intel would try to shut them down, too. The function of a processor can be protected under various intellectual property laws that vary by country. Emulating a CPU could be considered a violation of a CPU manufacturer’s rights without having a license to do so. Intel threatened Microsoft and Qualcomm over processor emulation back in 2017.

For now, if you need an Intel-only operating system, you have to keep Intel hardware running, which might include virtualization software for operating systems that aren’t the native one you boot into.






Back Up Your M-Series Mac

With each system release in the last few years, Apple has layered on more protection for system files and software. These improvements have made it ever harder for any kind of hacker, local or remote, to mess around with macOS to grab your data, watch you while you work, or commit other mayhem. In fact, Apple is so restrictive as of Big Sur that even when you’re logged into a running copy of macOS as the root user via the Terminal, you can’t make any changes to system files!

Generally, that’s good. But where it’s bad—or at least tricky—is in creating a full backup of your system that you can use to start up your Mac as an external drive, and restore exactly after erasing your Mac or to a new system. The M1 makes this even harder by having a unique combination of hardware features and requirements.

I would argue this is not bad, even though it can be irritating. In conversations with TidBITS editor Adam Engst and Take Control publisher Joe Kissell, I am increasingly convinced that bootable backups of your Mac may be less important now than ever before.

In this chapter, you learn about how Big Sur organizes its system and data files, and learn a strategy for making bootable backups—and whether you need one at all.


Learn About Big Sur’s Organization

Apple plays a long game. In 2016, they started to preview APFS (Apple Filing System), a freshly conceived filesystem that was optimized for SSDs, allowed a better organization of data beyond partitions, and incorporated lessons learned since Mac OS Extended (or HFS Plus) replaced an even earlier filesystem, plain old HFS, back in 1998.

In APFS, you can still partition a physical drive, allowing you to divide up available storage into different pieces. But within a partition, you can have one or more containers, which can dynamically resize as needed for their contents, which can be one or more volumes. Each volume has a role, which defines the kind of data they contain, like System, Data, Backup, Recovery, Preboot (a special volume handled at startup), and so on.

With the release of macOS 10.13 High Sierra in 2017, the macOS installer converted all SSD-based Macs to use APFS. The next year, 10.14 Mojave converted hard disk drive and Fusion drive Macs during an upgrade or installation.

But it wasn’t until 10.15 Catalina that we saw the real picture, when Apple introduced the concept of volume groups. These are sets of separate volumes in an APFS container that can present to the Finder as a single, bound-together unit. A startup container has multiple invisible volumes plus a volume group with system and Data volumes inside. Links between the two volumes let you navigate through a single entity in the Finder as if you were navigating just one volume. Nifty, but complicated.

In previous versions of macOS, Apple relied on System Integrity Protection (SIP) to lock down system-file modifications (see Control Big Sur’s System Integrity). With Catalina, Apple went further: all system files are placed on the system volume, which is set to be read-only. The operating system prohibits modifications. Your user data is on the Data volume, which can be read from and written to.

Big Sur goes one step further to ensure the system can’t be fiddled with, as I describe in complete detail in Control Big Sur’s System Integrity. During an installation or update of Big Sur—on both Intel and M-series Macs—the installer creates a Signed System Volume by producing a cryptographic “seal” when installation is finished. If the seal can’t be validated at startup, your Mac won’t boot into macOS, and it tells you to reinstall the operating system.



Make a Backup

As you can understand, Big Sur’s organization adds complexity in making a full bootable backup, or clone, of your system. You can copy anything from the Data volume, including the whole volume, but the system volume is something special.

M-series Macs have an additional requirement, too, for a bootable version of the startup volume that, from our analysis, appears to be hardware based.

Let’s start with figuring out which kind of backup is important to you, data-only or a complete bootable copy, and then proceed on how to make each kind.


Which Kind of Backup Do You Need?

With macOS prior to Catalina, it was trivial to make a clone of your entire startup volume. This had several advantages: you could boot from a clone if your regular startup volume failed; you could restore your clone to another Mac if your main Mac stopped working; and you could use it to migrate your setup to another Mac when you upgraded or changed your hardware out.

Starting in Catalina, Apple’s split of system and data makes it both harder and less useful to have a bootable clone. And all Intel Macs running Catalina or later or any Mac with Big Sur installed have an immutable system volume—nothing can be changed after an installation or update, so there’s no need as such to have a copy of it, because you can’t change anything in it. It’s also completely separate in its nature from the Data volume, which means you won’t have preference or other settings files that you might miss out on.

An M1 Mac makes a bootable clone even less critical, because if it cannot startup from its internal drive, you can’t boot it externally, either. (Drive failures are rare with SSDs, however.)

The only strong reason to make a bootable clone with an M-series Mac is if you want to be able to have a previous version of Big Sur available for testing. In many cases, that might not even be a clone as such. It might just be an external drive with Big Sur installed and some or none of your data files!




Can You Roll Back to an Earlier macOS?




Another potential reason to keep an older, bootable version of macOS handy is that Apple hasn’t made it easier to revert to an earlier version, particularly compared with older releases of macOS. Howard Oakley at Eclectic Light explains a number of strategies and limitations with trying to install an older Big Sur release on your M-series Mac.



Note: As of publication time, Joe Kissell is working on a new edition of his book Take Control of Backing Up Your Mac that will cover bootable duplicates, data backups, and a host of other backup approaches and considerations for both M-series and Intel Macs. We expect the new edition to be available by May 2021.




Back Up Just Your Data

Because the Data volume can be freely read and doesn’t have special requirements, you can back it up in part or full in a variety of ways. Each of these methods will let you restore all or part of your data to an M-series Mac that has a working version of macOS installed, or has just completed installing macOS and is prompting you for a source to migrate from.

Here are four approaches:


	Time Machine: Time Machine works perfectly fine with M-series Macs for backing up the Data volume.


	Local data-only clones: You can use Carbon Copy Cloner (and a handful of other apps) to copy the Data volume to another volume. CCC can also make an incremental backup, updating only changed files when you run it again.


Note: As of March 2021, Shirt Pocket’s SuperDuper! hasn’t caught up to making a simple backup of the Data volume.



	Cloud backups: All the usual suspects, like Backblaze and many others, support M-series data backups.


	Sync services: Box, Dropbox, Google Drive, iCloud Drive, and all the rest allow syncing files in their various sync folders.





Tip: If you want your backup to be encrypted when the drive isn’t plugged into your Mac, you can follow the instructions in Encrypt External Drives.




Make a Bootable Clone

You can make a bootable clone from your M-series Mac, though between Big Sur and Apple silicon changes, it’s a bit more complicated than with previous versions of macOS—even more so than Catalina.


Learn the Prerequisites for a Bootable Clone

First, you have to use a native Thunderbolt 3 drive. Take Control head honcho Joe Kissell and I both purchased an Other World Computing Thunderbolt 3 SSD enclosure and a compatible SSD to place in it.




Why Not Regular USB 3?




Technical gurus have tried drives with USB 3.1 or later over USB-C, which is fully compatible with the Thunderbolt 3 available on M-series Macs. But only some of these USB 3 interface drives will work as externally bootable volumes. No one as of March 2021 has figured out why, so there’s no way to predict whether a given unit (not just model) will work. Stick to Thunderbolt 3 if you need this option.


Second, the partition or drive with the system on it has to be erased every time it’s backed up. Because Big Sur seals the volume cryptographically, it can’t be copied in part. (Each update to Big Sur creates a new seal as well.)




Intel Macs Can Copy the System Volume




Each Mac’s startup drive is sealed in such a fashion that only a special Apple utility can copy it correctly to another volume. That software was updated for Intel Macs a few weeks after Big Sur shipped, allowing Carbon Copy Cloner to update a backup’s system volume by copying it, but fully overwritten the previous copy. So far, that tool remains unavailable for M-series Macs.


Third, your clone requires a one-time pass through recovery mode after it’s created to let it boot from an external drive due to increased security in M-series Macs.



Proceed with Making the Bootable Clone

With that in mind, attach the Thunderbolt 3 drive to your Mac, and:


	If it’s not yet formatted, you’ll see a prompt that offers Initialize as an option. Click that, which launches Disk Utility.


	If it’s already formatted, launch Disk Utility.





Warning! Just to reiterate, since you’re erasing the drive, if there’s any data on it, make sure it’s backed up before you wipe it.


Now, do the following:


	Choose View > Show All Devices.


	Select the drive in the sidebar and click Erase.


	If it’s not selected already, select APFS with nothing in parentheses after it as the Format. Leave Scheme set to GUID Partition Map.


	Click Erase and confirm the operation. When it’s complete, click Done.




I recommend using Carbon Copy Cloner (CCC) to clone your Data volume because of its simplicity and the progress and feedback it affords while you’re underway.


Note: It is possible to use Disk Utility for this task, too, but the rigidity and complexity makes both me and editor Joe Kissell advise against it.


With Carbon Copy Cloner, you can either clone the Data volume of your Big Sur startup drive to the external bootable drive (optionally adding Big Sur to the same volume later), or you can install Big Sur first. Thus you can complete either of the next two tasks in either order: install Big Sur first and then clone your Data volume, or clone your Data volume and then install Big Sur.


Install Big Sur on Your External Drive

Start this process by installing Big Sur on the external drive. You can do either of the following:


	Download the Big Sur installer from the App Store via this link, and install Big Sur onto the external drive while macOS is running.


	Follow these steps to install from recoveryOS:


	Restart in recoveryOS (see Restart in recoveryOS).


	Select Options and click Continue.


	Select a user account, click Next, enter that account’s password, and click Continue.


	Click the Wi-Fi  icon in the upper-right corner if it’s not lit up and connected to a network, choose a network, and enter its password if required. (You need an internet connection.)


	Click Reinstall macOS Big Sur and click Continue.


	On the setup screen, click Continue, then click Agree and Agree again.


	Finally, you can select the external volume as your target, click Continue, and follow prompts (Figure 5).








[image: Figure 5: You can select which disk to install (or reinstall) Big Sur onto from the recoveryOS version of the installer.]Figure 5: You can select which disk to install (or reinstall) Big Sur onto from the recoveryOS version of the installer.

During the installation, your Mac will restart from the external volume to complete the installation.

When installation is complete, you have two choices:


	Big Sur migration: When prompted by the Big Sur installer to migrate data from another “computer,” you can select your internal drive, and it will copy it entirely to the external drive. We’ve tested it and it works, and it’s automatic.


	Manual Carbon Copy Cloner copy: If you have trouble with the Big Sur migration, want more control over how the copying happens, or want to be booted into macOS and using it while the cloning happens in the background, follow the instructions next to start up again from your internal volume to copy the Data volume.




Because the system volume can’t be cloned, whenever macOS is updated and you want your bootable clone to be up to date, you must follow the steps just below to restart with your external drive, then go to System Preferences > Software Update and install the latest updates. When that’s complete, you can restart again from your internal drive.



Clone Your Data Volume to Your External Drive

To copy your Data volume exactly to your external drive, follow these steps:


	Go to System Preferences > Startup Disk and select the internal drive.


	Choose Apple  > Restart.


	When the Mac restarts and you log in to macOS, quit all apps that might make changes during the clone operation in the next step, such as anything that downloads files locally or stores them locally.


	Open Carbon Copy Cloner and clone the Data drive from your Mac to the external drive. CCC is set up to prompt you through the steps to perform this operation.




You can now routinely update the Data volume from CCC or any other cloning or sync software.




Encrypting a Bootable Clone




It’s not possible as I write this in March 2021 to create an encrypted bootable clone of your M-series Mac, or any kind of encrypted startup volume.

In our testing, you can start up from an external drive with an M-series Mac and then enable FileVault. But whether you restart while it’s still in progress—which his fine with an Intel Mac—or after the FileVault encryption is complete, you cannot successfully then restart from that volume.

It seems that this is either a bug that Apple needs to fix, or they need to update macOS to not allow FileVault encryption on an external drive. In either case, right now you can’t have a bootable backup drive that’s protected by encryption.





Restart from Your Bootable Clone the First Time

Apple imposes an additional requirement the time you start up from an external drive to enhance security on M-series Macs. Each boot from anything but the internal drive requires a specific passthrough operation in recoveryOS to authenticate. You will need to repeat this for each update.


Note: This replaces the Firmware Password used to manage starting up from an external drive on Intel Macs.


Here’s how to handle a first-time external boot:


	Go to System Preferences > Startup Disk and select the external drive.


	Choose Apple  > Shutdown.


	Restart in recoveryOS (see Restart in recoveryOS).


	Select your external volume among the drives listed at left and click Continue (Figure 6).





[image: Figure 6: Select a startup drive from recoveryOS.]Figure 6: Select a startup drive from recoveryOS.


Note: You can also click Options and choose Apple  > Startup Disk, select a drive, and click Restart and confirm by clicking Restart. For drives with macOS protected by FileVault, you can select the volume, click Unlock, choose an account and enter its password, click Unlock, and then click Restart and Restart.




Eject Your Bootable Clone

When you restart with an external drive attached that has a valid System and Data volume group on it, typically only the Data volume appears, and it shows up with the main system name, excluding the “- Data” portion. To eject it, select the drive and choose File > Eject. When prompted, click Eject All; otherwise the System drive will remain silently mounted (Figure 7).


[image: Figure 7: You must click Eject All or a lingering part of the drive will remain mounted.]Figure 7: You must click Eject All or a lingering part of the drive will remain mounted.





Restore Fully from a Backup

You can, of course, restore portions of your Data volume, like sets of files or folders, using any normal retrieval process, including Time Machine for selected folders. If you are trying to rewind the entire volume back in time, you need to use other methods.

Because of Big Sur’s organization, you can’t restore as easily as in, say, Mojave and earlier releases. With Mojave, you can restart in recoveryOS and use Disk Utility to restore an entire disk image or volume onto your startup drive. When it’s complete, just restart, and you’re back in business.

But that’s not a valid process with Big Sur. Instead, you need to follow these steps across three different cases.


Restore Just Data

If you don’t need to reinstall macOS, and you have a volume or disk image that has just the Data volume (created via Carbon Copy Cloner, for instance), you can restore via recoveryOS:


	Attach the drive that has the Data volume backup on it.


	Restart in recoveryOS (see Restart in recoveryOS).


	Select Options and click Continue.


	Select a user account, click Next, enter that account’s password, and click Continue.


	Click Disk Utility and click Continue.


	Choose View > Show All Devices.


	Select the Data volume for your startup drive (Figure 8). If it’s dimmed:


	Select the volume.


	Click Mount.


	Select a user for that volume and enter that user’s password, then click Unlock.


[image: Figure 8: Select the Data volume with great care to avoid writing data the wrong correction.]Figure 8: Select the Data volume with great care to avoid writing data the wrong correction.





	Click Restore.


	From the “Restore from” menu, select the backed-up Data volume. In the figure above, that’s I Can BOOT - Data.


Warning! Make sure you follow those steps exceedingly carefully. The Data volume you select in step 7 must be the destination volume, or the one that will be erased and replaced with files from the volume you select in step 9. I can’t emphasize this enough that you should read the text under “Restore to ‘volume name’?” extremely carefully before clicking Restore and confirming.



	Click Restore and confirm that you want to restore from that volume.


	Wait for the process to complete.


	Choose Disk Utility > Quit.


	Choose Apple  > Startup Disk, select the startup volume, click Restart, and then confirm by clicking Restart again.






Restore from Time Machine

Apple offers an easy path to restore from a Time Machine backup:


	Make sure the drive with your Time Machine backups is attached to the Mac.


	Restart in recoveryOS (see Restart in recoveryOS).


	Select Options and click Continue.


	Select a user account, click Next, enter that account’s password, and click Continue.


	Click Restore from Time Machine and click Continue.


	Follow the prompts to select and restore your Time Machine snapshot.






Reinstall macOS and Your Data

If you need to install or reinstall a version of macOS, you can follow the steps in Make a Bootable Clone to install macOS from recoveryOS. Once that’s complete, you can use either of the previous options to restore your Data volume.






Work with Extended Battery Life

There’s a point while reading superlatives when your eyes rightly glaze over. I know I have a very low limit for it. Which is why I sometimes feel like a huckster and shill when people ask me about the battery life of an M1-based Mac laptop. It’s ridiculous. It’s absurd. I’m nearly embarrassed to talk about it, because it’s so danged huge.

Apple’s M1 chip consumes energy so efficiently that it can carry out processor-intensive tasks over a long period of time and consume what seems to be somewhere between one-third and one-half as much battery power as a comparable Intel laptop. Sometimes, even less.

And when you’re performing more normal tasks, like reading articles in a web browser or using a word processor, or simply leaving your Mac active and not engaged in working on it, the battery seems to go on and on and on and on. I’ve taken my Mac off power and left it by accident, and several hours later come back and find that its charge remains nearly full.

I’d wager that for some people, they could work for two full business days in a putative post-pandemic world of commuting or travel without plugging in. That’s the kind of performance associated with an iPad.

In this chapter, I detail how Big Sur charges and manages batteries so you understand how best to keep your battery in fine fettle. And how to use macOS and third-party tools to keep on top of current time left and charging cycles to maximize battery life and longevity.


How Batteries Charge and Cycle

Lithium-ion (Li-ion) batteries are a modern miracle that effectively made mobile devices feasible, as well as electric cars and much else. Unlike previous generations of batteries used in vehicles and electronics—odd bedfellows there—Li-ion batteries hold energy densely while discharging slowly when not in use. They also lack the dreaded “memory effect” found in older rechargeable batteries, when a battery that’s not fully discharged starts to get stuck at a maximum recharge limit that’s far below its actual maximum capability.

Developments a few years ago allowed manufacturers to move away from a battery-cell approach, in which Li-ion batteries were in a form factor similar to alkaline and nickel metal hydride (NimH) rechargeable ones. A “polymer” form of Li-ion allows them to be shaped in all sorts of ways. Apple used this effectively to fill in all the empty spots in an iPhone with battery, and to create the equivalent of layered shingles of batteries to fill the insides of laptops.

The real limit with Li-ion batteries is carefully charging them to the safest full capacity. Overcharging one of these batteries or battery packs can lead to excessive heating, which can cause a fire.


Warning! If you ever see a bulgy part of a device where its battery is, immediately stop charging the device, and if possible put it in a metal bucket on a concrete floor where there’s air circulation. Bulging typically happens when internal safeguards in the lithium-ion cells have been damaged or it’s been overcharged, and a runaway reaction can occur that can result in a dangerous fire. This Macworld column I wrote has additional safety and disposal advice as does this Battery University article.


This is why “100%” isn’t really 100% when it comes to Li-ion charging. Even with a fresh device, the “100%” charge is 100% of what the battery maker and the device maker decide is the safest amount to charge a given battery. There’s always additional capacity that’s left in reserve to avoid overheating.

There’s also an inflection point in charging at 80% of current capacity. Below 80%, a charger in a device charges at effectively full speed, although devices with battery temperature sensors factor that in, such as Mac laptops that can run Catalina and Big Sur.

At 80%, however, charging slows dramatically to something more like a trickle, because it’s easier to overwhelm the battery at this stage. This is all managed behind the scenes, of course, and better hardware does a better job in managing this last little phase. But it also explains the phenomenon you’ve certainly noticed that your battery-containing devices charge really fast and then really slow.

Li-ion batteries lose capacity as they age, and thus “100%” charged on your Mac’s battery icon after two years could be 70% of the original “100%.”

Apple says that its laptops should retain 80% of their original maximum capacity after 1,000 charging cycles. A cycle isn’t every time you plug in, but a measure of charging to 100%. So if your battery is at 50% and is charged to 100%, that’s half a cycle. Firmware tracks the number of cycles and other data.

The other fly in this Li-ointment is that the more a device’s battery is charged to its putative 100% capacity, the more wear that’s put on the battery. It’s better to charge to something like 80% to preserve the longevity of the battery and avoid the cost of premature replacement.




AppleCare Covers of Battery Replacement in Many Cases




Apple includes battery replacement under AppleCare warranty program. With the included 1-year warranty, Apple replaces a defective battery at no cost. That can include a battery that has dropped below 80% capacity within a year, but you may have to argue with them about that.

Under the AppleCare+ paid warranty extension, however, if the battery ever falls below 80% within the three years of coverage, you can get it replaced without any debate. The cash price for battery replacement is $129 to $199 depending on your Mac laptop model.

You can check on your current battery capacity before your 1-year or 3-year warranty is up by holding down Option and choosing Apple  > System Information, then clicking the Power link in the sidebar. Look at Cycle Count and Maximum Capacity. For vastly more information not displayed here, consult the third-party utility that I describe in Use a Third-Party Battery Utility.


It’s tempting to want your battery charged to what the display says is 100% all the time, so when you remove it from AC power, you have the maximum charge on the go. But then you pay for that later as the full charge ebbs from running your Mac for, say, 15 hours to 10 hours, to 7.5 hours, and then you’re frustrated and get the battery replaced.

That’s why Apple changed its approach in macOS, which pays particular dividends with an M-series Mac.



Examine Your Charging in macOS

Apple has a mixed history with battery charging—not that their history is terrible, but it took them an awfully long time to prioritize improving their operating systems to better manage a set of well-understood characteristics about Li-ion batteries.

For Macs, specifically, it wasn’t until Catalina that Apple shifted from the approach of charging to 100% when plugged in to charging based on a monitored pattern of usage and the temperature of the battery. Big Sur improved this further by showing a detailed chart of usage and charging across 24 hours and across 10 days.

With “Optimized battery charging” selected in System Preferences > Battery, macOS customizes when charging proceeds past 80%. It only charges to 100% with a clever logic: if it predicts you will be taking the laptop off power within the period of time that it can charge it to 100%.

You can see this in the graph in Figure 9, found in the Battery pane’s Battery view, which shows 24 hours of usage, including a separate bar chart for when the screen was lit up. The charging line at the bottom of the Battery Level section shows the times when the laptop was plugged in. And the “Last charged to 100%” label at right lets you know the last time macOS took the battery to full. You can also view a more succinct 10-day history (Figure 10).


[image: Figure 9: Big Sur displays a pattern of battery usage and charging over time.]Figure 9: Big Sur displays a pattern of battery usage and charging over time.


[image: Figure 10: Over 10 days, more patterns emerge.]Figure 10: Over 10 days, more patterns emerge.




A Battery Charging Example




My description can be hard to wrap your head around. Here’s a real-world example. You always plug your MacBook Air in overnight. You leave the house every day at 8 A.M. to head into an office. (For some of us, that’s a wistful or distant dream.)

With optimized charging enabled, if your battery is below 80% when you plug it in, it will be charged to 80% and more or less kept there—and an idle M-series Mac consumes little juice. At some period before 8 A.M. on a weekday when you normally unplug your Mac, based on macOS’s prediction of how long it will take to charge to 100%, it starts actively charging again.

There’s some leeway, too. If you leave at 7 A.M. one day, you won’t find yourself with an 80% charge. You can also override the constructed schedule, as described next.


You can see how macOS is handling the current charging situation by clicking the battery  icon in the menu bar (Figure 11). As shown, charging has halted (“On Hold”), the battery is at 80%, and macOS informs you this Mac is Rarely Used On Battery. If plugged in and charging, you see an estimate of the time to a full charge. If Charge to Full Now appears, you can select it to override the hold status.


[image: Figure 11: The Battery menu lets you see how macOS is managing the charge and gives you information and an override.]Figure 11: The Battery menu lets you see how macOS is managing the charge and gives you information and an override.

Click the Battery button and then the Battery Health button, and you can see the state of your battery, including its current capacity relative to its original (Figure 12).


[image: Figure 12: You can find out more about the battery’s current health, useful for diagnosing problems.]Figure 12: You can find out more about the battery’s current health, useful for diagnosing problems.

Battery health is automatically managed on an M-series Mac laptop. There’s an option to override it on Intel Macs, but Apple doesn’t offer that—presumably because power management is part of the SoC and there’s no less-healthy mode that’s available.



Use a Third-Party Battery Utility

Apple reveals a modest amount about the state of your battery. For vastly more detail, often useful in figuring out optimizing charging further or troubleshooting what’s going wrong before taking it in for repair, I recommend Battery Monitor from Marcel Bresink Software.

The app provides extensive detail about the battery pack of cells in your Mac, and it works on M-series Macs as well as Intel models. Among other details you can find at a glance are the total number of charge cycles, the maximum capacity for the battery pack as shipped and current capacity, and the battery pack’s status, such as current charge and temperature (Figure 13). Note that M-series batteries have a serial number.


[image: Figure 13: Battery Monitor reveals a host of measurements.]Figure 13: Battery Monitor reveals a host of measurements.

Whenever you launch Battery Monitor, it adds an entry about capacity for that day that’s tracked by battery, either by serial number or another unique indicator. If you use the utility over time or keep it running, this generates a chart of battery decline.

Because I’ve updated my laptop from a 2015 12-inch MacBook to a 2020 MacBook Air through migration, you can see the history of where my original battery rapidly declined (at far left, in orange), and then how the warranty-replacement second battery (middle, red) also suffered an only slightly less rapid pattern of wear (Figure 14). This was largely before Catalina and its battery optimization software, which contributed to the problem.


[image: Figure 14: A previous MacBook’s initial battery failed quickly, but its replacement didn’t fare much better.]Figure 14: A previous MacBook’s initial battery failed quickly, but its replacement didn’t fare much better.

The app has several other charts that you can run over shorter intervals from 1 to 48 hours, to track voltage and other parameters. Most of the time, these aren’t useful unless you’re trying to test out the battery usage of an app or peripheral, see how long your M-series laptop can hold out, or are sorting out a problem and want to have an informed conversation with Apple about warranty repair.





Understand recoveryOS

Apple’s separate recovery operating system (recoveryOS) has been a vital part of troubleshooting your Mac since it first appeared about a decade ago. It’s also where you go when you need to make changes to certain low-level and security settings that can’t be modified while macOS is running.




macOS Recovery, recoveryOS, and Recovery Mode




Apple seems to be in a transition point about what it calls this special boot mode on a Mac. The best we can figure it at Take Control Books is that there are three terms in use:


	Recovery mode is the generic term for a recovery boot process in macOS, iOS, iPadOS, and all Apple operating systems.


	macOS Recovery used to be the term that referred to restarting into Mac recovery mode. If you start up an Intel Mac by holding down ⌘-R, the app that appears has a header labeled macOS Recovery, in fact. macOS Recovery is used in some of Apple’s user-facing manuals and documentation online.


	recoveryOS looks to be a new term, one we first saw in the Apple Platform Security document, which is aimed at security researchers and system administrators, as well as in some IT-focused guides. recoveryOS apparently refers to the special limited-purpose operating system that runs recovery mode on a Mac. On an M-series Mac, when you restart in recoveryOS, there’s no header label. It’s only when you click Options and authenticate that the main recovery “app” appears and is still labeled macOS Recovery—this is just confusing and may change. (And you might be prompted at the login window, if you delay entering your password for a while, to restart in… ”Recovery OS.”)




Since we’re only talking about working with M-series Macs in this book, I have chosen to use the new term recoveryOS for the general state of booting in recovery mode, because it’s the most consistent available name.



Restart in recoveryOS

To enter recoveryOS on your M-series Mac:


	Choose Apple  > Shut Down.


	When you see your Mac has powered down, hold down the power button until you see a prompt that says “Loading startup options.”


	A set of one or more drives appears along with a gear icon labeled Options. (It may take tens of seconds for all drives to appear.) To continue with Options, you select Options, click Continue, select an account, enter its password, and click Continue.


	A screen appears on which you can click to select from among four tasks or choose other options from the Utilities or Apple  menu.




I describe how all these options in step 3 and 4 work across the rest of this section.




M-Series Macs Have Fewer Boot Modes




Intel Macs have a variety of keyboard shortcuts and buttons you can press to trigger starting up in several different modes, like internet recoveryOS, diagnostics, Safe mode, Single User Mode, and others.

M-series Macs have just four: macOS, recoveryOS, fallback recoveryOS (described below), and safe mode (described next).





Start Up in Safe Mode




In safe mode, macOS won’t load any kernel extensions (kexts) you’ve added. This can solve startup problems related to buggy extensions. You won’t need it often.

To boot in safe mode, restart in recoveryOS as above. In Step 3, hold down the Shift key when your startup drive appears, click Continue in Safe Mode, and release the Shift key. Your Mac restarts in safe mode. Restart again to boot up normally.



Fallback To Move Forward

You may be fascinated to discover that recoveryOS has a doppelgänger: there’s not just one recoveryOS, but two of them. The primary one works as expected and is booted into as above. But Apple has hidden a second fallback recoveryOS, that’s a failsafe in case something goes wrong with the primary system.


Note: This is how NASA handles its satellites, probes, landers, and rovers: it has an A system and a B system (and sometimes even more) in case something goes boom. If A fails, B fires up to keep things running, and can sometimes automatically diagnose and fix A.


In an ideal world, you should never need to trigger fallback recoveryOS: either you never need it, or it will automatically boot if it detects a problem with the primary recoveryOS.

The main difference between the two is that you can’t apply security policy changes using the fallback version as described in Modify Startup Security with a Utility. Instead, you can reinstall macOS, which will fix the original recoveryOS.


Note: Howard Oakley at Eclectic Light explains that the fallback recoveryOS probably won’t be on your system until you install the first update to your M-series Mac. He also provides instructions on how to check whether it’s present.


To restart into fallback recoveryOS intentionally, in step 2 above, double-press and hold the power button instead of pressing down and holding it. This press/release/hold sequence triggers the emergency backup.

The fallback recoveryOS coupled with the firmware revive and restore process I explain later in this chapter, in Revive or Restore a Broken Startup Volume, replaces and expands on the Internet Recovery feature that’s built into the boot ROM (read-only memory silicon chip) of an Intel Mac.

An Intel Mac’s Internet Recovery feature is a last-ditch option that can be triggered by holding down ⌘-Option-R, and which downloads and installs the recoveryOS via an internet connection. In contrast, fallback recoveryOS is part of a disk-based installation, and can fail if the SSD fails or the Data volume in Big Sur is corrupted. There’s no recovery option built into ROM.

However, the revive and restore operations described later rely on a special mode you can invoke in M-series Macs (and Intel Macs with a T2 chip) that let you connect to the internet to repair firmware required for booting up, or overwrite it if it can’t be repaired. This is a bit more complicated than plain Internet Recovery, but provides more nuance for fixing a problem, too.



Share Within recoveryOS

As part of enhanced protections on M-series Macs, Apple no longer allows the simple option of restarting your Mac and holding down the T key to enable Target Disk Mode and have the Mac mounted on another Mac as a volume.

Instead, you have to follow these steps to share a volume, which makes it appear as a networked volume on the other Mac:


	Restart in recoveryOS as noted above in Restart in recoveryOS.


	Choose Utilities > Share Disk.


	Select the disk to share, and click Start Sharing (Figure 15).


[image: Figure 15: Sharing your M-series Mac as a disk requires using a special recovery mode.]Figure 15: Sharing your M-series Mac as a disk requires using a special recovery mode.


Note: If the disk is encrypted, you can click Unlock, choose an account, and enter its password.



	Connect your Mac to another one via a USB data cable (with Type-A or USB-C plugs on either or both ends) or a Thunderbolt 3 cable.


	On the other Mac in the Finder, click the Network link in the sidebar to view the shared Mac’s volume.


	Click the Mac in the main window, click Connect As in the upper-right corner, select Guest as the user, and click Connect.




You can now transfer files between the two computers. When complete, eject the mounted Mac volume by selecting it and dragging it to the Eject icon in the Dock or pressing ⌘-E.



Master the Ins and Outs of Recovery

recoveryOS includes several other features, presented as apps, some of which are labeled macOS Recovery:


	Restore from Time Machine: Use this option to restore the Data volume of a backup.


	Reinstall macOS Big Sur: This allows you to reinstall macOS on the internal or on an external volume.


	Safari: You can access Safari via a sort of guest account that lets you browse, but doesn’t let you launch other apps or store permanent settings.


	Disk Utility: Sometimes you need to run operations against the internal or other volumes without being booted into macOS.


	Utilities > Startup Security Utility: To learn more about the Startup Security Utility, see Modify Startup Security with a Utility.


	Utilities > Terminal: Launch Terminal to perform command-line actions while in recoveryOS.


	Apple  > Startup Disk: Startup Disk is an app of sorts instead of a preference pane in recoveryOS. To learn more about setting the startup volume, see Make a Bootable Clone.




Some of the above options require internet access. recoveryOS retains previous selections and passwords for Wi-Fi networks you’ve already connected to. If you don’t see an active connection, however, click the Wi-Fi  icon, select a network, and enter its password if it has one.




Revive or Restore a Broken Startup Volume

Your Mac might become unresponsive and not start up properly in either macOS or recoveryOS in rare circumstances. This typically means that both the firmware that handles startup and some aspects of encryption aren’t working, the fallback recoveryOS has failed, and macOS has a problem. Yikes.

The most obvious cause is when a macOS update is underway and your AC-powered Mac loses power (as with an M1 Mac mini) or your Mac laptop runs out of juice. It can also happen randomly: Odd corruption? Cosmic rays? Who knows exactly!

If you can’t get your Mac to start up in any fashion, Apple offers two special operations—revive and restore—accessible through a piece of free software it makes available largely for system administrators called Apple Configurator 2. (These modes are also available for T2-equipped Intel Macs, but work slightly differently with those models.)

Here’s the difference between the two operations:


	Revive fixes the firmware and other problems without erasing any of your data. You may have to reinstall macOS afterwards, but your files will be retained.


	Restore is a last-ditch effort to get your Mac to boot again. It performs a full reset that blasts the firmware, dumping anything stored in the Secure Enclave, and also erases your drive en route to reinstalling macOS. None of your data is retained.




You also need a USB-C cable that supports just USB 3—that is, it has USB-C on both ends and isn’t a Thunderbolt 3 cable. It must also be a data cable, not the charging cable Apple ships to connect a Mac laptop to an AC adapter or one from another maker. (Read my article on determining which kind of USB-C cable you have.)

The steps are quite complicated, and Apple offers an extensive support document with illustrations that will help. The article has even more details, along with some graphics, than what follows if you need additional steps. Here’s what to do:


	Install Configurator 2 on the Mac that will be reviving or restoring the M-series one. (It requires Catalina or later.)


	Plug the restoring Mac into power if it’s a laptop, and make sure it has an active internet connection.


	Connect the USB-C cable between the restoring Mac and the appropriate port on the unresponsive M-series Mac:


	On a Mac mini, that’s the left of the two Thunderbolt 3 ports on the back


	On the laptop models, it’s the left of the two Thunderbolt 3 ports on the left-hand side





Note: Wild, huh? These ports have special firmware powers.



	Launch Configurator 2 on the restoring Mac.


	Make sure your Mac is in a fully powered down state and then get it into the correct state by model type:


	With a Mac mini, make sure a monitor is plugged in so you can watch progress in step 6. Disconnect the Mac from power for at least 10 seconds. Hold down the power button, reconnect power, and release the power button. Its status light should be amber. It will also appear as a selectable item in Configurator 2.


	With a Mac laptop, press the power button and then keep holding it down while also pressing three keys: the right Shift key, the left Option key, and the left Control key. Release the modifier keys after about 10 seconds, but keep holding down the power button until you see your unresponsive Mac appear as an available selection in Configurator 2.





	To revive, in Configurator 2, select the Mac in the device window, and then choose Actions > Advanced > Revive Device and click Revive Device. The Apple logo will intermittently appear and disappear on the Mac that’s being revived, and then the Mac will reboot. You may be prompted to reinstall macOS, but this will be a non-destructive operation.




If your Mac functions normally at this point, you can unplug cables and stop.


Warning! If you select restore in the next step, all your data on the Mac being restored will be erased.


If your Mac is not functioning correctly, proceed as follows:


	Restart at step 5 above to get your Mac back in its special mode and appearing as a selection in Configurator 2.


	In Configurator 2, select the Mac and then choose Actions > Advanced >Restore and click Restore. As with revive, the Apple logo will intermittently appear and disappear.


	If the restoration was successful, your Mac restarts with the macOS Setup Assistant. Unplug cables and proceed.




At this point, if you can’t use your Mac, it’s time to call Apple Support to get additional help, as it may require a repair or replacement.





Manage System Security

Apple has built in a number of excellent protections in recent years against a combination of physical intrusion, in which someone can sit down in front of your Mac and attempt to break in, and system integrity, in which system files have been increasingly immutable.

In this chapter, I explain three major elements of system security that are different on an M-series Mac and that you may find yourself needing to work with or around.


Note: For a full dive into macOS security for Intel and M-series Macs, read my book Take Control of Securing Your Mac.



Protect a Drive with FileVault

The current version of FileVault was developed for Mac OS X 10.7 Lion way back in 2011, where it combined two separate features: software-based full-disk encryption (often called FDE) with a special startup and login mode that worked with a fully encrypted disk. (Apple later added dedicated silicon to Macs to accelerate encryption.)

With the introduction of the T2 Security Chip in Intel Macs, Apple separated FDE from the FileVault login mode. On T2-equipped Macs and M-series Macs, which have a Secure Enclave, the internal drive is always encrypted. FDE is always on and can’t be disabled.

Intel Macs still require a special startup mode in recoveryOS, but M-series Macs no longer do: they boot into macOS directly.

So what’s the difference with an M-series Mac between FileVault enabled and disabled? Here’s the distinction:


	With FileVault disabled, the startup process automatically retrieves the volume’s security key in a process mediated by the Secure Enclave. The Data volume is decrypted even before an account password is successfully entered. That leaves an inch of room for an attacker to try gain access, difficult as it might be.


	With FileVault enabled, a Mac with Apple silicon boots from the System volume; the Data volume remains fully encrypted. Once the password for a user account is successfully entered, macOS can retrieve the encryption key that protects the Data volume, and unlock it for use.





Note: If the SSD drive were removed from a Mac—which in modern Macs is nearly infeasible—the decryption information would remain in the Secure Enclave that’s left behind. But taking the whole computer still leaves the problem of breaking into the Secure Enclave, which has proven so far highly resistant to attack.



How macOS Manages FDE

While FDE is not a feature of FileVault as such with an M-series Mac, since encryption is always enabled, FileVault does mediate how a Mac’s startup drive becomes available after it starts up or restarts.

Full-disk encryption puts a layer between the operating system and a storage drive that automatically decrypts all information coming off the drive and encrypts it as it’s written. This means all information whenever it’s stored on the drive—when it’s at rest—is fully encrypted. This includes when the Mac is in use and when it’s powered down.

Only while a Mac is active is stored information vulnerable to interception, as macOS must hold the encryption key in memory to allow it to encrypt and decrypt data on the fly. This allows macOS to treat an encrypted volume as if it were effectively not encrypted at all while in use, including letting you share the volume over a network; back it up to an external drive, a networked volume, or an internet service; and use sync services like Dropbox, iCloud Drive, and OneDrive.

Whenever any Mac with FileVault enabled is shut down—whether an M-series model or a pre-T2 Intel Mac—its startup drive is an inaccessible vault, with no more information accessible than a lump of solid metal. The key material necessary to decrypt its data can’t be accessed.




Encrypt External Drives




You can choose to encrypt any mountable SSD, HDD, or disk image that isn’t configured as a macOS startup drive. There are two primary ways to encrypt non-startup volumes:


	Control-click or right-click in the Finder: Control-click or right-click the volume and choose Encrypt. Enter and verify a strong password, preferably one you generated in a password-management app. Add a hint if you think it will help. Click Encrypt. This converts the drives in the Finder without losing any data. It will happen in the background and may take quite a while. (Disk Utility can change a volume’s format type to the encrypted flavor, but it always erases the volume—and warns you before you proceed.)


	Disk Utility for disk images: Disk Utility can create an encrypted disk image via a different method. Choose File > New Image > Blank Image, then choose 256-bit AES from the Encryption pop-up menu. You’re prompted to enter and verify a password, but not store a reminder tip. Set other parameters as needed and click Save.




You have to enter the volume or disk image’s password to mount it in the Finder or to access it via Disk Utility. When mounted, the drive appears as fully decrypted to the Finder, just like a startup volume with FileVault, and can be shared, synced, and backed up.

Apple notes carefully that passwords created for any encrypted drive but the startup volume aren’t managed in the Secure Enclave.




Enable and Manage FileVault

Because Apple made the decision for security reasons that FDE is always enabled on M-series Macs, these Macs take just seconds to enable or disable FileVault’s remaining feature: securing the Data volume at startup.

You manage FileVault’s state via System Preferences > Privacy & Security. Here’s what to do:


	Open System Preferences > Privacy & Security > FileVault.


	Click the lock  icon and use Touch ID to unlock the pane if available. Otherwise, enter your administrator username and password, and click Unlock.


	Click Turn On FileVault.


	macOS prompts you about how to handle the Recovery Key, which I explain the nature of further just below: you can opt for “Allow my iCloud account to unlock my disk” or “Create a recovery key and do not use my iCloud account” (Figure 16). Make your choice and click Continue. (You can also cancel at this stage, or click Back.)


[image: Figure 16: Two distinct choices shape a possible recovery.]Figure 16: Two distinct choices shape a possible recovery.


	If you opted to create a recovery key, it appears now, once, and never again (Figure 17). Record it; see below.


[image: Figure 17: I can show you this key, because I regenerated it.]Figure 17: I can show you this key, because I regenerated it.




FileVault is now enabled.


Tip: If you can’t get FileVault to turn on, there can be some very frustrating low-level problem at work. I tracked down some solutions at Macworld with the help of readers.


In some cases, you may see an option labeled Enable Users, which lets you select which users may log in via the FileVault process from a cold start or a restart. Click that button and review which users aren’t enabled. If you want to add them, you select the user, enter their password, and click OK.


Note: I’ve discovered in more recent testing that Apple no longer appears to offer Enable Users as an option, except in cases in which some non-administrator accounts already existed. All new accounts are automatically granted FileVault login privileges.


You can disable FileVault by clicking Turn Off FileVault, which happens almost instantly on an M-series Mac.



Consider Security and Integrity with the Recovery Key

The FileVault Recovery Key is a precious object that you should treat like the gold that it is virtually made of. If anything goes wrong with the elements of your Mac’s startup process that storage and manage passwords for accounts, or in the unlikely event you forget the password to your computer’s account, the Recovery Key is the only way you can decrypt the drive. Without it—and any backup that is accessible—its contents are truly gone for good.

Apple, knowing this, allows you to store the Recovery Key in your iCloud account. It’s not available for you to view or retrieve manually: it can only be retrieved through the recovery mode process that allows you to unlock FileVault when no account password will work. (See Apple’s support note on resetting your password with the Recovery Key for details.)

However, if you let Apple store the key, then it is protected only by normal iCloud credentials. That has three implications:


	If you lose access somehow to your iCloud account, which can happen, the key is not retrievable. (In that case, you should immediately turn FileVault off and back on, which generates a new Recovery Key unrelated to the previous one.)


	If someone gains access to your iCloud credentials, they could unlock a Mac you own that they have access to by using the FileVault recovery process.


	A government agency, rightly or wrongly, could force Apple legally or extrajudicially to provide this key for a device they had seized or otherwise obtained. To my knowledge, this has never occurred, but it’s possible Apple would be constrained from revealing it in any country in which it occurred; that seems unlikely given the company’s stance on encryption and privacy.




If you choose to create a Recovery Key locally, you need to copy it down immediately before dismissing the dialog. I made a Secure Note in 1Password with it, as I trust the protection behind 1Password and have access to 1Password data on other devices, securely synced.




Why Use a Password Manager for the Recovery Key?




Because I sync 1Password and I have my 1Password access details available offline (a combination of written and memorized), I could lose all my devices besides my Mac and have it locked in a way that requires Recovery Key and still regain access to Dropbox.





Control Big Sur’s System Integrity

Earlier I described how APFS, Catalina, and Big Sur progressively changed the nature of how macOS is organized on a drive, and how it starts up and protects system files. Let’s dig into that a little further here in how it relates to system integrity—and how to work around that when you need to.

Unlike Catalina, which first split macOS into a read-only system volume and a read/write user Data volume, Big Sur doesn’t even mount the system volume. Instead, it uses the “snapshot” feature of APFS that allows the filesystem to capture a particular point in time.

In Big Sur, a snapshot of the system volume is only created after the system drive’s contents are validated through a chain of cryptographic trust. The snapshot cannot be changed, because it has no writable components—it’s like looking at a picture. As you can see in Figure 18, the system is marked as an APFS System Snapshot, and has a unique name, while the main system volume is dimmed. (This is coupled with system files being locked for either execution or writing, too, as described in “Hardware-based memory protection” in Other Hardware Security Upgrades.)


[image: Figure 18: The Big Sur system is really a snapshot of the actual volume, making it double secret read-only status. The callouts show how it’s identified in Disk Utility in this way.]Figure 18: The Big Sur system is really a snapshot of the actual volume, making it double secret read-only status. The callouts show how it’s identified in Disk Utility in this way.

During installation of Big Sur, on both Intel and M-series Macs, the installer creates a Signed System Volume by producing a cryptographic signature when installation is finished. M-series Macs can only run Big Sur (and eventually later releases), and has a hardware-based check that lets it validate that the system is authorized by Apple, and that the Big Sur seal hasn’t been “broken,” which is detectable if a single bit were changed on the system drive after installation. If the seal can’t be verified, you’re prompted to reinstall macOS!

On an M-series Mac, there’s another layer of protection. Every file has its own signature, which is stored in the system volume’s metadata, and that metadata is also cryptographically signed. Every time a system app runs or a file is read, Big Sur on an M1 Mac validates that the underlying data hasn’t changed since boot. Whew!

With all that in place, Big Sur and Macs with Apple silicon block you by default by booting into anything but the latest version of macOS. However, you can work around this with the Startup Security Utility, which allows reducing the level of restrictions.



Modify Startup Security with a Utility

Apple boosted security starting with T2-equipped Macs as only they could only when they had absolute control over the entire boot process, something made possible by the Secure Enclave and other elements.

Apple let Intel Macs have more leeway about what kind of systems it could boot, which allowed not just Boot Camp, but also other native Windows and Linux installations, and more exotic options.

The M-series Macs are much more locked down, at least for now. I expect over time for Apple to provide a pathway to allow booting from other systems, partly because it lets them sell hardware to people who don’t want to run macOS or don’t only want to run macOS.

You change boot security policies via the Secure Startup Utility accessible via recoveryOS. See Restart in recoveryOS to restart in that mode, and then choose Utilities > Secure Startup Utility.

While Intel Macs let you disable security altogether, an M-series Mac has just two available standard security modes (Figure 19). By default, Full Security is selected. This option allows your Mac to run either the current macOS that’s installed on your startup volume or the latest macOS trusted by Apple. A fun fact about Full Security is that it requires an internet connection; when you install or update macOS, your Mac sends a unique ID based on the CPU installed on your individual Mac to an Apple “signing server.” That server produces a cryptographic signature tied to your Mac, which means that the version installed cannot be run on any other Mac.


[image: Figure 19: Select the appropriate level for your needs.]Figure 19: Select the appropriate level for your needs.


Note: I would call out that Apple doesn’t say “macOS” but rather “signed operating system software currently trusted by Apple.” That would seem to open the universe to a Microsoft-authorized version of Windows designed to run on an M-series Mac? Perhaps I’m reading too much into it.


Reduced Security expands the universe of possible versions of macOS that can be installed. This allows as well for non-unique copies of macOS to run—ones that aren’t tied to a specific Mac as above.

Reduced Security also adds the option to select or deselect the ability of a user to install signed kernel extensions; and for remote management, which is used in schools and businesses, to control these kernel extensions and software updates. Some organizations may need particular extensions for security software, and may also want to delay automatic software updates in case of incompatibility or support burdens.


Warning! With Reduced Security enabled on Macs with Touch ID, Apple Pay cannot be used entirely on that device. You can still approve Apple Pay payments in Safari via an iPhone connected to the same iCloud account, however.



Note: Some third-party software still relies on kernel extensions for low-level access to hardware. Several of Rogue Amoeba’s apps use the ACE extension (really an audio plugin that Apple treats like a kernel extension) for grabbing and managing audio.


With an M-series Mac, access System Security Utility by following these steps:


	Restart in recoveryOS, click Options, and authenticate with a valid account. (See Restart in recoveryOS.)


	Choose Utilities > Startup System Utility.


	The app launches. Click Unlock to mount the disk, which will be encrypted, and then enter an administrator user and password and click Unlock.


	Select the volume (even if there’s just one) and click Security Policy.


	Select the level of security you want to apply and click OK.


	Quit the utility and choose Apple  > Restart.







Permissive Security for Limited Purposes




There is a hidden third security mode, Permissive Security, revealed if you disable System Integrity Protection (SIP). It allows a very particular kind of installation, in which researchers and others create custom kernels outside of the Apple-signed ecosystem of macOS operating system versions compatible with M-series Macs. This will be used extremely rarely, and it comes with severe risks. I address SIP and these details in Take Control of Securing Your Mac.






Launch iOS and iPadOS Apps on Your Mac

One of the most surreal things you can do on an M-series Mac is install and launch apps designed for iOS and iPadOS. Because the M-series Mac has a compatible ARM-based processor, mobile apps can run across those three platforms. (macOS apps can’t run in iOS or iPadOS…yet?)

Not every iOS and iPadOS app can run, but most can. Touch-based actions have to be mapped to ones that can be performed with a mouse, trackpad, or keyboard, too. But it’s a surprisingly seamless process.


Find and Install Mobile Apps

The Mac App Store now offers both macOS apps that developers have made available for download, sale, or subscription through Apple, and iOS and iPadOS apps.

Unfortunately, you can’t browse through categories to find mobile apps. You have to either follow a direct link to an iOS or iPadOS app or search by keywords or by name. For instance, search for “calculator” and you will see two items under “Results for ‘calculator’”: Mac Apps and iPhone & iPad Apps. Click the latter link, and the results are all mobile apps (Figure 20).


[image: Figure 20: The App Store lets you select iPhone & iPad Apps in search results.]Figure 20: The App Store lets you select iPhone & iPad Apps in search results.

All apps will show either “Designed for iPhone” or “Designed for iPad.” Apps designed for both appear to show only the iPad label, though. Obtaining an app and downloading it is just the same as with any Mac app in the App Store or in the iOS and iPadOS App Stores (Figure 21).


[image: Figure 21: Just click the price, confirm the purchase, and the game is downloaded to your Mac.]Figure 21: Just click the price, confirm the purchase, and the game is downloaded to your Mac.

You can also click your avatar in the lower-left corner of the App Store or choose Store > View Account, and then click iPhone & iPad Apps to see apps you purchased on any App Store. You can then download them to your Mac.

Apple offers developers frameworks that allow mobile apps to work best inside macOS without making many changes in their iOS and iPadOS apps. You will see the label “Not verified for macOS” for apps that don’t take advantage of these frameworks.

App developers can opt to exclude their mobile apps from appearing as available for M-series Macs. Apple lists a number of reasons why a developer may make that choice in their coding documentation, which include requirements for sensors built into iPhones and iPads not present in Macs, restricting access to the code innards of apps (which can be readily viewed in macOS), or having a touch-focused approach that won’t work well on a Mac even with substitutions described below.




You Can’t “Sideload” Apps




There was briefly a period when people figured out a way to load iOS/iPadOS apps via the Apple Configurator 2 software, bypassing the App Store installation process. Loading apps directly onto a device is called sideloading. Apple quickly blocked the capability.




Use Mobile Apps

iOS and iPadOS apps appear in the Applications folder (or elsewhere) just like an any other app and can be launched any special arrangement.

You can choose after launch how to interact with the app. Choose App name > Touch Alternatives, which may be automatically enabled. If not, you can choose it to enable it. Doing so brings up a dialog with instructions (and an OK button to dismiss it), which can be viewed later by choosing Help > Touch Alternatives (Figure 22).


[image: Figure 22: Touch Alternatives lets you use the keyboard and trackpad or mouse to simulate touch input.]Figure 22: Touch Alternatives lets you use the keyboard and trackpad or mouse to simulate touch input.

When you hold down Option to simulate touch and multi-touch, a highlighted circle appears on screen where each finger is positioned on the trackpad to help you mentally connect the two actions.

If you opt to not use Touch Alternatives, then you’re reliant on how the app interprets keyboard and mouse input. For apps that have been updated to be macOS “verified,” and for iPad apps that consider the use of a cover with a keyboard build, a keyboard connected via the Lightning port or Bluetooth, or a mouse or trackpad connected through any means, you may be able to interact very naturally with the app without the touch-like assist.





Install and Use Windows

A popular use of high-performance Macs has been to run Windows. At times, the fastest machine that could run Windows was in fact a Mac. Apple even made this an authorized function way back in 2006, by adding Boot Camp, a utility that manages installing Windows and starting up your Mac into it.

With the first M-series Macs, that went out the window. There’s no Boot Camp, and no production release of Windows for M1 Macs.


Note: Emulators that could pretend to be an Intel processor don’t yet exist for Apple silicon, either. As noted in Run Old and New Code on an M1, the only way to run Intel-based operating systems on a Mac is to have an Intel Mac.


That could change, however. Apple’s head of software engineering, Craig Federighi, told Ars Technica back in November 2020 that Microsoft could opt to license ARM-based Windows for Mac users.

In March 2021, there is one simple way to run a limited version of Windows on an M1 Mac: Parallels Desktop for M1 Technical Preview, a beta-testing release.


Get Windows 10 for ARM

Start by obtaining the version of Windows 10 that works with ARM installations. It’s in beta, so you can’t simply purchase or download it. However, Microsoft makes it extremely easy to set up a free developer account and download it.

Here’s how to get the Windows 10 for ARM beta:


	Start with the Windows Insider Preview Downloads page for “Windows 10 Client ARM64 Insider Preview.” You will be prompted to login in. If you don’t have an Outlook.com or Live.com account, follow the steps offered to create one.


	Return to the downloads page, if you aren’t automatically redirected. You should be prompted to agree to Windows Insider terms. Make sure you read what you’re agreeing to and then check the boxes offered.


Note: Editor Joe Kissell found himself stuck at step 2. He wasn’t able to agree to terms and proceed. Instead, he had to register separately for a Windows Insider account and complete the process from within an existing running copy of Windows 10. I didn’t encounter this.



	Click “Windows 10 Client ARM64 Insider Preview - Build xyz”; a build number appears in lieu of xyz, and will change over time. The download is roughly 9 GB and will be named something like Windows10_InsiderPreview_Client_ARM64_en-us_21286.VHDX.




Set the file aside until you’ve completed one or both of the next two emulator installations.


Note: After you complete an installation with an emulator, follow the instructions in Windows 10 when prompted to log in to the account associated with your Windows Insider membership. You will also get instructions on enabling optional diagnostics, which is required to download incremental updates to Windows 10 in the beta program.




Install Windows 10 with Parallels

The easiest way to install Windows 10 is to use the Parallels Desktop for M1 Technical Preview. Here’s how to obtain and install the beta:


	Visit the Technical Preview page. You will need to create a free Parallels account if you don’t already have one. Log in to that account.


Note: You may be told that you have to wait to receive an email that you are admitted into the technical preview program.



	Under Step 3 on the page, click Download.


	Make a note of the Activation Key, as you will need that after completing the installation.


	Open the disk image file, and double click Install.app.


	Be patient, as it seems as if some background operations occur before any action displays. After a few tens of seconds, I saw a “validating” progress bar for the desktop app. When complete, the installer quits without additional information.


	Launch Parallels Desktop from the Applications folder.


	Choose Parallels Desktop > Account & License and enter the activation key you noted above.


	Navigate to the Windows 10 Client ARM64 installer file or click Find Manually and drag and drop it into the window.


	Follow prompts to create the virtual machine, which are quite straightforward. You can opt to configure some settings before launch, but those can also be changed afterwards.




The Windows 10 virtual machine should now launch (Figure 23). (If you have problems, read this technical note at Parallels’s site.)


[image: Figure 23: The very nifty sight of Windows running in Parallels running in macOS on an M1 Mac.]Figure 23: The very nifty sight of Windows running in Parallels running in macOS on an M1 Mac.




A Free Emulator: QEMU




An alternative to Parallels, which will charge for its M1-compatible Desktop app when it enters production, is the open-source and free QEMU processor emulator. Unlike Parallels, QEMU offers almost no hand holding, and requires a reasonable amount of technical expertise on your part to manage from scratch.

Fortunately, a kind soul built out a full-fledged and free Mac front-end on top of QEMU called UTM. It can also be downloaded in identical form from the Mac App Store ($9.99), but the fee goes to support development.

Editor Joe Kissell and I were unable to follow the steps in this detailed guide to get us to a working version of Windows, so we can’t recommend this at the moment unless you have a lot of time to burn and understand emulator and Terminal arcana. I’m sure it will improve for an average user, and we’ll document it in a future version of this book when it does.
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